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Safety notes 
This manual includes notes which you must observe for your own personal safety and for the prevention of property 
damage. These notes are highlighted with a warning triangle and are listed according to the degree of hazard they 
represent:

Danger
indicates that death, severe personal injury or substantial property damage will result if proper precautions are not taken. 

Warning
indicates that death, severe personal injury or substantial property damage can result if proper precautions are not taken.

Caution
indicates that minor personal injury or property damage can result if proper precautions are not taken.

Caution
indicates that property damage may result if proper precautions are not taken.

Attention
indicates important information on the product, its handling or the corresponding part of the documentation to which the 
reader’s attention is to be drawn.

Qualified personnel
Commissioning and operation of a device may only be performed by qualified personnel. Qualified personnel in terms of 
the safety notes given in this manual are persons who are authorized to commission or start-up devices, systems or cir-
cuits, to earth and to label them according to the relevant standards of safety technology. 

Approved purpose
Please note the following:

Warning
The equipment may only be used for the applications specified in the catalogue and the technical description and only in 
connection with third-party devices and components recommended or approved by Siemens.
Correct and safe operation of the product requires appropriate transportation, appropriate storage, installation and moun-
ting as well as careful operation and maintenance.

Trademarks SIMARIS® is a registered trademark of SIEMENS AG. 
All other brand names in this publication may be trademarks the use of which by third persons for their own purposes 
may infringe the rights of their registered owners. 

Copyright Siemens AG 2002 All rights reserved
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prior written consent. Infringements shall entitle to damage 
claims. All rights reserved, in particular in case of a patent grant 
or utility model registration.

Disclaimer of liability

Although we have carefully checked the contents of this publica-
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SIEMENS What can I do with SIMARIS deSign?
A Introduction

A.1 What can I do with SIMARIS deSign?

SIMARIS®deSign supports the planning of electrical power supply 
systems in buildings worldwide. SIMARIS deSign automatically di-
mensions the following for the resulting network:

• the power requirement of the system infeed (higher-level net-
work, transformer or generator)

• the medium-voltage switchgear
• the cross-section of the low-voltage cables/wires
• the number of cores in the low-voltage cables/wires
• the low-voltage protective devices
• the type of distribution board
• the space required for the enclosures

SIMARIS deSign provides a complete solution based on the techni-
cal properties of the equipment.
SIMARIS deSign A-1



What can I do with SIMARIS deSign? SIEMENS
SIMARIS deSign offers you the following for your project documen-
tation:

• single-line circuit diagram
• enclosure front view and base cutouts
• calculation results
• current-time characteristics
• the sum total of the list prices for the low-voltage distribution 

boards including devices
• texts for tender documents

Before you start to work with SIMARIS deSign, please read the li-
censing terms carefully.

Warning
SIMARIS deSign supports you when designing the power supply. 
The plausibility of the results from SIMARIS deSign must be exam-
ined by an expert.
A-2 SIMARIS deSign



SIEMENS How do I work with the SIMARIS deSign User Manual?
A.2 How do I work with the 
SIMARIS deSign User Manual?

To facilitate your orientation, the user manual is divided into three 
sections:

Chapter A.3 General Information
In this section you can find information

• about the properties of the program.

Chapter A.4 - A.9 Introductory Example
When you work through these chapters, you will learn

• how to use SIMARIS deSign.
• how you can design the configuration with SIMARIS deSign 

more efficiently.

Chapter A.10 - A.13 Appendix
In these chapters you can find help for concrete questions which 
might arise when you regularly configure with SIMARIS deSign:

• important terms and abbreviations in SIMARIS deSign
• recommendations for further reading and information
• a template for necessary information about the loads and the 

distribution boards
SIMARIS deSign A-3
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A.3 Which program features do I need to 
to know?

A.3.1 Allocation of mouse functions
Left mouse button

• activation of the drop-down list of tree nodes
• selecting tree nodes/browsing
• pressing buttons
• selection of lines in a list box
• selection of menu items

Centre mouse button
or (if a function has already been allocated to it) double-clicking on 
the left mouse button

• activates the text field of the node
• activates the drop-down list of distribution boards

Right mouse button
• polling the context menu for the respective node 

(detailed Information in the menu descriptions)

Double-clicking on the right mouse button
• Direct polling of the respective Properties dialog boxes
A-4 SIMARIS deSign
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A.3.2 Calculation module
The calculation module is divided into several sections:

 

   Messages

Menu and
  tool barStructure tree

Network diagram
SIMARIS deSign A-5
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1. Toolbars

You can control the functions of the module with the toolbar. 
The toolbar is divided into several functional groups:

File

You can create a new project or open or save an existing project.

Inserting medium voltage

You can insert a medium-voltage level with a downstream low-
voltage network or unloaded transformers.

Adding a transfer link

You can add an outgoing cable to another subnetwork. 

Only one link is allowed per subnetwork, which is to be selected 
directionally starting from an output distribution board. 
SIMARIS deSign supports the selection of the destination distri-
bution board by suggesting all permissible destination distribution 
boards.

Inserting low-voltage 
circuits

You can insert circuits such as the system infeed, distribution 
boards or loads.The circuits are automatically added within the hi-
erarchy below the distribution board selected in the calculation 
tree. Depending on the position in the tree, these functions are 
only partially available.

Editing missing input boxes

In sequence you can poll all of the Properties dialog boxes with 
missing input.
A-6 SIMARIS deSign
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Properties

Displays the properties of the selected circuit.

Editing

Editing functions such as copy & paste are stored here.

Undo / Redo

These buttons are used to undo completed editing steps in the 
program as well as to redo steps which have been undone.

Dimensioning

You can start the dimensioning of devices or enclosures. You can 
dimension both entire networks and individual network sections.

View

The display format of the network diagram can be selected here. 

Zoom

The display size of the network to be displayed in the network 
diagram can be selected here.
SIMARIS deSign A-7
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2. The window area with the structure tree

The structure tree is based on the functionality of  Windows Explorer. 
By double-clicking on the icon or clicking on the nodes in the struc-
ture tree, you can activate a drop-down list of the branches. 

The structure tree is divided into several sections: 
• Under Planning > Calculation you can set up the electrical 

network.
• Under Planning > Definition Enclosure the respective switch-

gear cabinets can be selected and dimensioned. The dimen-
sioning of the enclosure is always related to the network under 
Calculation. If this network has not been completely dimen-
sioned, no respective distribution board can be selected. If the 
dimensioning has been carried out correctly, all of the nodes in 
the structure tree are marked with a green icon.

• All of the administrative data relating to the current project is 
listed under Project data.
A-8 SIMARIS deSign
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3. Network diagram window / Enclosure window

This window graphically displays the circuits listed in the structure 
tree. 

In the node Calculation > Network1:

The structure tree is displayed in the network diagram window in the 
form of an electrical block diagram. The circuit selected in the struc-
ture tree is highlighted by a blue border in the network diagram.

In addition, device and circuit data is displayed in the network dia-
gram window for each device. You can select four different data 
masks:
 

Single-line diagram with device 
parameters

Giving an overview of the rating and the default settings of the cir-
cuit. This is the standard view.

Single-line diagram with load flow/
load distribution

The properties of the network and the equipment during operation 
are displayed here.

Single-line diagram with short-circuit 
load

An overview of the properties of the network and the equipment 
in the event of fault. 

Energy balance

An overview of all of the types of power and the inrush apparent 
current at the nodes.
SIMARIS deSign A-9
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In the node Definition Enclosure > Network1:

Detailed information about the enclosure components is displayed in 
the right section of the window.

4. Message box

This window in the lower section of the screen displays messages, 
errors and notes that have arisen during the network calculation. 
These could be caused by false, incomplete or non-permissible cir-
cuit settings. 

If you click on one of the messages, the affected circuit in the struc-
ture and network diagram window will be highlighted.

Selectivity

In this view you can 
• observe and evaluate the tripping performance of each pro-

tective device in terms of the short-circuit current and up-
stream and downstream devices. 

• manually adjust the protective settings for adjustable devic-
es.

Since the properties are dependent on the type of device, this 
view is only available after dimensioning.
A-10 SIMARIS deSign
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A.3.3 Planning module
There are up to four icons for each node of the structure tree. These 
include: 

• Circuit icon
• Selectivity status
• Hand icon

Example:

Circuit icon

This icon shows which category the circuit belongs to. There are: 
• (Sub-) distribution boards
• Fixed loads
• Non-stationary loads
• Capacitors

Along with the Distibution icon, main distribution boards also receive 
a designation for the number of parallel  infeed circuits leading to the 
busbar.

Circuit Selectivity
SIMARIS deSign A-11
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SIMARIS deSign supports the progress of your work by displaying 
the nodes in the structure tree in different colours depending on the 
status of the work:

YELLOW
You still have to input default settings for this circuit. It is imperative 
to at least enter the cable length.
When you have fulfilled this condition, the circuit becomes grey.

RED
In any case, this item must still be processed. This circuit has not 
been dimensioned, i. e. SIMARIS deSign has not selected any de-
vices for this circuit. Notes on the causes can be found in the mes-
sage window, see chapter A.7.9 Trouble shooting. 

GREEN (or BLUE)
This circuit has been correctly dimensioned.

GREY
All of the data for this circuit is available for the calculation, however 
the circuit has not been dimensioned. 

TIP
If you are colour-blind (red/green), select blue icons. You can modify 
the colour settings via the menu Extras > Settings. In the Settings 
dialog box, select Desktop > View.

Selectivity icon

SIMARIS deSign supports you in evaluating the selectivity of your 
network. The circuit can be evaluated in terms of both overload 
selectivity and short-circuit selectivity.

The icon in the structure tree displays the state of the circuit:

GREEN
The characteristic curve of this circuit does not intersect with the en-
velope curve of the upstream devices within the evaluated range.
The circuit is fully selective within the evaluated range.
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SIEMENS Which program features do I need to to know?
YELLOW
The characteristic curve of this circuit intersects the envelope curve 
of the upstream devices within the range of IN and the smaller Ik,min.
The circuit is partially selective.

ORANGE
The characteristic curve of this circuit intersects the envelope curve 
of the upstream devices within the range  >= Ik,min.
The circuit is partially selective.

GREY
The ciruit has not been dimensioned yet. It is not possible to give any 
information on selectivity.

TIP
Detailed information on the selectivity of a switch can be displayed 
in the message box.

1 Open the Extras > Settings menu.
2 In Desktop > Messages, select whether messages about 

selectivity
- are not to be displayed.
- are only to be displayed for partially selective combinations.
- are to be displayed for both partial selectivity as well as for full 
selectivity.

Hand icon
You have manually modified at least one device in this circuit.
This device will not be taken into consideration when the automatic 
dimensioning is carried out. In the network diagram, you can see 
which device is stationary.
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Input box

Input boxes with a RED background
An inadmissible value is listed in the input box. You have either ex-
ceeded or fallen below the defined intervals. A tool tip will inform you 
about the permissible interval.

TIP
If you enter the value via the keyboard, the background will momen-
tarily turn red since both spaces and zeros are inadmissible values 
in the text box. When you continue writing, the colour will change 
back to white.

Input boxes with a YELLOW background
The entered value deviates from a standard default setting. The in-
put is technically possible, however it is not normal.
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A.4 How do I work efficiently with 
SIMARIS deSign?

The following chapters are geared toward new users of 
SIMARIS deSign. 

These chapters provide you with a quick introduction to the 
SIMARIS deSign software. 
In this example you will generate the power supply for a high-rise 
building with a elevator. You will quickly configure this network with 
SIMARIS deSign according to the selected standards and regula-
tions for installation.

With this example you will learn the functionality of SIMARIS deSign:
- Starting the program
- Working with default settings
- Inputting and editing the network
- Selectivity observation
- Defining the enclosures
- Exiting the program

The purpose of the model network is to familiarize you with the ap-
plication of SIMARIS deSign and to motivate you to try it out and test 
it.

Install the software (the functionality of the demo version is also suf-
ficient) and follow the project as described. 
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A.4.1 Introductory example

The company TUTORA EVENT is planning a new branch office in 
the industrial park in Any Village.

Your customer has turned to you with an initial architectural drawing:
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SIEMENS How do I work efficiently with SIMARIS deSign?
Your customer needs the following at short notice for the further 
planning stages:

- block diagram of the electrical network
- network calculations
- estimation of the space needed for the power supply
- specifications of work and services for the power supply

You have learned the following from the conversation with your cus-
tomer and the drawings:
The offices are to have the same functionality on all floors:

• The system infeed is carried out via the 20 kV network of the 
local power utility. The transformer power is to be minimized.

• The cables are to be laid free below the ceiling. 
• The entire project will be executed inexpensively using both 

fused and fuseless technology. 

Lighting 20 kW

Outlets for PCs etc. 2.5 kW; with 50 % in reserve

Kitchen 7 kW

Elevator 50 kW

Air conditioning 50 kW
SIMARIS deSign A-17



How do I start my project in SIMARIS deSign? SIEMENS
A.5 How do I start my project in 
SIMARIS deSign?

A.5.1 Preparation
In order to work efficiently with SIMARIS deSign, several points must 
be taken into consideration in advance:

A.5.1.1 Determine the similarities

- Look for corresponding factors in the power supply requirements 
for your project.

- Make a note of the information about the type of desired equip-
ment. 

- What do you know about the connections, their installation type, 
the switchgear and the fuses? 

- Construct a standard case which applies for most of the cases in 
your project. 

- Clarify in advance the standards and the general settings for the 
network to be created.

A.5.1.2 Strive for the creation of a modular structure

Select typical loads for the default settings. To save time, you can 
use these repeatedly using copy & paste.

TIP
When you start a new project, begin by compiling a list of loads and 
distribution boards:

• List all of the loads with their technical data.
• Group these into distribution systems.
• Delegate these distribution boards and further necessary loads 

to one (main) distribution board.
• Repeat this procedure until you have reached the system in-

feed.
• Specify your infeed.

A respective list for this example can be found in chapter A.13. 
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SIEMENS How do I start my project in SIMARIS deSign?
A.5.2 Registering as a SIMARIS deSign 
license holder

Before starting SIMARIS deSign, you will be asked to enter your li-
cense key:

If you already have a valid license key, enter it now and then click on   
Next. The license key will now be checked and SIMARIS deSign will  
be activated for unrestricted use.

If you have not yet received a license key, you must register with 
SIEMENS AG and request a license key.
SIMARIS deSign A-19
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If you click on Next without entering a license key, you will have the 
following options:

• Starting SIMARIS deSign in demo mode
• Requesting a license key via the Internet
• Requesting a license key per fax

The fax form can be found under <local drive>/SIMARIS/
Projects/design/templates.

When requesting the license key, please ensure that you have your 
authorisation code at hand. The authorisation code is enclosed with  
the certificate you received together with the software.

After you have registered, you can start SIMARIS deSign by clicking 
Continue in demo mode. The requested license key will be sent to 
you either by e-mail or by post.

You are entitled to receive a license key if you are the owner of a 
complete version (single-user or multi-user license). 
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Online Registration

• In order to receive your license key via the Internet, click on
Register - Online.

• Your Internet browser will automatically start and connect you 
to the SIMARIS website.

• Fill out the registration form:
• In the Authorisation code input box, enter the authorisation 

code you received with your order confirmation.
• The input boxes marked with  *  must be filled in in order to be 

able to send the form.
• When all of the relevant input boxes have been filled in, click on 

Send.
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• After  you have registered successfully, the following message 
will appear:

• Your data will now be transmitted to the SIMARIS deSign help-
desk and you will receive your valid license key via E-mail 
within one day. 

• Until you receive your license key, you can start 
SIMARIS deSign by clicking on Continue in demo mode.
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Offline Registration

• Click on Register - Offline to receive your license key per fax. 
The fax form will be automatically started in Word. 

• Fill in the input boxes and send the fax to the number listed in 
the letter head. Enter your authorisation code in the Authorisa-
tion code text box. The authorisation code is listed in the cer-
tificate you received with your order confirmation.

When you receive your license code, you can enter it 
• when you re-start SIMARIS deSign.
• via the Administration > License menu during the application
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A.5.3 Starting the program 

1 Start SIMARIS deSign 
• via the menu Start > Program > Simaris > 
SIMARIS deSign

• by double-clicking on the icon on the desktop. 

2 After a short load time you will be requested to enter your user 
name and your password. 

Register using your personal user name. When you start 
SIMARIS deSign for the first time, Administrator will be listed 
in the User text box. Leave this default during the practice 
example.
A-24 SIMARIS deSign



SIEMENS How do I start my project in SIMARIS deSign?
3 Register with your personal password. As a standard the 
Administrator has not been allocated a password. When you 
start the program for the first time, simply confirm with OK.

4 Select the user interface language for the current session. If 
you have selected several languages from the product data-
base during installation, select one language from the drop-
down list box for the current session. You can select between
• German
• English (GB)

You can change the user interface language during the session.

5 Confirm with OK.
If the name and the password are correct, the program will begin 
with the Management module.

ATTENTION
If you do not have user identification or if an error message appears 
when registering, please contact your SIMARIS deSign administra-
tor. 
SIMARIS deSign A-25



What does the Management module provide? SIEMENS
A.6 What does the Management module 
provide?

This module supports three main functions:

- project management 
- user management
- customer management
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A.6.1 Registering a customer
1 In the Management structure tree, click on Customers.

An input form will appear on the right side. If you have not yet 
registered any customers, this list will be empty. 

2 Click the New button.
3 The New customer dialog box will appear.

4 Enter a customer number. 
This text box is mandatory. If you do not enter a customer 
number, the text box will be highlighted in red.

5 Enter the company name of the model project, TUTORA 
EVENT, in the Company text box. 

6 Click OK. 
The new customer name will now appear in the list below the 
input mask.

The registration of the customer has now been completed.
Select a data line to modify the customer data in the upper text 
box.
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A.6.2 Registering a user

1 In the Management structure tree, click on User.

An input form will appear on the right side. Below this list a list 
appears in which the administrator is entered as the only user.

Select a data line to modify user data in the upper section. 
Then confirm your modifications with Save.

2 To register a new user, click the New button.
3 The New customer dialog box will appear.
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4 Enter johnqpublic as the user name. 
Since it is mandatory to fill out this text box, it is highlighted in 
red.

5 Enter your data in the other text boxes as desired.
6 Click OK. 

The new user will now appear in the list below the input mask.

The registration of the user has now been completed.
Select a data line to modify the customer data in the upper text 
box.
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A.6.3 Creating a new project
1 In the Management structure tree, click on Projects.

2 Click the New button.
3 Enter the predefined data in the subsequent input box:

Project name: TUTORA1 
Short description of the project: Building
It is imperative to enter both the project name and the short 
description.

4 Confirm with OK. 
SIMARIS deSign will change over to the calculation module.
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AA.7 How do I work in the Calculation 
module?

A.7.1 Specifying default values and settings
In the global properties you define the default settings for your 
network elements and the settings specifically designated for this 
project.

These default settings will always be taken into account by the pro-
gram when you add new networks and circuits.

Define the global properties in the structure tree under Project > 
Planning > Calculation.

To modify the properties of your project, 

• click with the right mouse button on the Calculation node and 
select Properties in the context menu.

• double-click the node with the right mouse button.

• select the node with the left mouse button and click on the
Properties icon in the toolbar. 
SIMARIS deSign A-31



How do I work in the Calculation module? SIEMENS
ATTENTION
If you do not wish to specify any settings at this time, it is possible to 
do so later. However, the properties should be defined here in such 
a way that they correspond to the requirements of the project. De-
pending on the size of the project, modifications to an existing net-
work made at a later time can be very time-consuming. Always start 
with the default settings which apply for the majority of the circuits 
used in the project. 

ATTENTION
SIMARIS deSign takes the requirements of the current VDE 0102 
and IEC/EN 60909 into consideration. 
All of the networks are calculated with a new low-voltage factor 
cmax. This can lead to conflicts with existing projects that have al-
ready been dimensioned. Information on the current norm and stan-
dard values can be found via Network > Properties.
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A.7.1.1 Defining the medium voltage system infeed for the 
network

1 Double-click on Calculation with the right mouse button to 
display the dialog box for the global properties.

2 Select Project > Medium voltage > Default settings > Gen-
eral > Dimensioning from the structure tree.

Deactivate the Automatic switchover from the switch dis-
connector to the circuit-breaker check box to save priority 
fuse/switch disconnector combinations where these are per-
missible.

3 Select Project > Medium voltage > Default settings > Sys-
tem infeed > Higher-level network from the structure tree.
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4 Enter the following values in the text boxes of the Higher-level 
medium voltage network section:
Nominal voltage Un [kV]: 20
Max. short-circuit power [MVA]:  550
Min. short-circuit power [MVA]:   250
Neutral-point connection: compensated

For recording the earth fault detection at the medium voltage 
side Irest thus applies.
In the 20 kV network this current is approximately 3 % of ICE. 
For the model network, enter 50 in the input box for capacitive 
earth-fault current ICE [A] and 1.5 in the input box for earth-
fault residual current Irest [A].

5 Apply the standard settings of the equipment for the example.
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A.7.1.2 Defining the low-voltage system infeed

1 Select Project > Low voltage > Default settings > System 
infeed > Transformer from the structure tree.

2 Select Transformers with MV, i. e. transformer with higher-
level medium voltage.

3 Apply the standard settings for the parameters:
Rated voltage [V]:  400
Network system/connection to earth: TN-C
Frequency [Hz]:  50

4 Select 1 Transformer per 1 busbar section

As an alternative, you can also specify a preference for a network 
without medium voltage.

1 Select Generator without DMT from the structure tree.
2 Apply the standard settings for the parameters:

Rated voltage [V]: 400
Network system/connection to earth:TN-C
Frequency [Hz]: 50

3 Select 1 Generator per 1 busbar section.
SIMARIS deSign A-35



How do I work in the Calculation module? SIEMENS
A.7.1.3 Defining cables for the circuit

All cables in the introductory example should be laid in an identical 
manner:

1 Select Project > Low voltage > Default settings > Equip-
ment > Connections from the structure tree.

In the right section of the window you can enter all of the prop-
erties for the type of connection.

2 Click in the Type of connection text box and select Cable/
line from the dropdown list box.

3 Click the Installation type? button to determine which instal-
lation is coded.
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In the Selection of installation type dialog box you will find 
images of all available installation types for each cable type. 
You can limit the selection with the help of the input boxes. 
Then the image bar will only contain those installation types 
which are permissible within the set limitations.

4 Click on the Installation type text box and select free from the 
drop-down list box. 

5 Click on the Installation site text box and select Below ceil-
ing from the drop-down list box.
With these limitations, you can now only select installation 
type(s) C.

6 Click in the vicinity of Image and confirm with OK.
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7 Check the contents of the other text boxes:
Enter a general value in the Reduction factor ftot text box. 
An empirical value is often 0.7. 
You can specify this value either via the drop-down list box or 
by directly entering the value. 

TIP
If you enter the value via the keyboard, the background will momen-
tarily turn red since both spaces and zeros are inadmissible values 
in the text box. When you continue writing, the colour will change 
back to white. 
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A.7.1.4 Defining switches for circuits

All of the low-voltage switches should be identical in the beginning:
1 In the ‘Default settings global’ dialog box, select Project > 

Low voltage > Default settings > Equipment > Switches 
from the structure tree. 

2 Circuit-breaker is the standard setting for the Switch Selec-
tion input box. Retain the standard selection.

3 Earth fault detection for all types of circuit-breakers is acti-
vated as the standard setting if required. Retain the standard 
selection to always insure automatic tripping in case of indirect 
contact.
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A.7.1.5 Determining the properties of the circuits

SIMARIS deSign supports you in evaluating selectivity.
1 Select Project > Low voltage > Default settings > Electrical 

circuit > I-t diagram option from the structure tree.
The stipulations that are valid for a circuit at the beginning are 
listed in the right section of the window in the Selectivity view. 

2 Select Circuit properties from the structure tree and the 
option Back-up protection in the right section of the window 
for cost-effective dimensioning.

3 In the Standard setting, partial selectivity is checked within 
both the overload range as well as the short-circuit range. 
Accept this setting for the example.
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A.7.1.6 Defining loads for circuits

Specify a template for fixed loads by selecting the data for both of 
the large loads, the air conditioning and the elevator, as the standard 
settings:

1 In the ’Default settings global’ dialog box, click on Project > 
Low voltage > Default settings > Load > Fixed load.

2 Enter  50 in the Active power [kW] text box.

Specify a non-stationary load:
1 In the Default settings global dialog box, click on Project > 

Low voltage > Default settings > Load > Non-stationary 
load.

2 Enter 7 in the Active power [kW ] text box.
3 Accept the pole number 3+n and set the capacity factor ai to 1. 

You have now specified the default settings for the project to be 
planned.
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A.7.1.7 Selecting the settings in the low-voltage network

In the mask you can find settings, i. e. manipulated variables which 
you can select as planning conditions and which directly influence 
your project. There are separate settings for medium and low volt-
age.

1 Select Project > General > Settings.
2 For this example, accept Destination country: Germany  as 

the standard setting. 

TIP
If you want to use the selected default settings quite often, you can 
save them. To do this, select the Save as default setting button. To 
use a saved default setting, click on the Load default button and se-
lect the desired file. 

3 Confirm your entry with OK.

Conditions for the specific medium voltage network include:
- general network data
- standard values
- the higher-level network
- default specifications for downstream low-voltage networks

Values which are valid for the entire network include:
- general network data for medium and low voltage
- standard values for low voltage
- dimensioning target for medium and low voltage
- calculation factors of the low-voltage components
- parameters of the low-voltage system infeed
- Enclosure preferences
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A.7.2 Adding a network
The system for adding networks, distribution boards and loads is set 
up strictly hierarchically. This structure is parallelled in the operation. 
The starting point for the circuit is always the Calculation node.

TIP
When you start to plan a network, it is advisable to first compile a list 
of all of the loads and to delegate them to specific distribution 
boards. An example of such a list can be found in chapter A.13.

1 Select the Calculation node.
2 Click on the Add medium voltage icon. 

TIP
If you would like to enter a network without defining a higher-level 
medium voltage, drop step 2 and add a low-voltage network directly 
below the Calculation node.

3 Click on the Add network icon.
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A node Network1.1 will be added with an assigned main distribution 
board.to your structure tree.

SIMARIS deSign is equipped with a number of different views of the 
network diagram. The Single-line diagram with device parame-
ters view is activated as the standard setting.

The icons in the structure tree have different colours. This corre-
sponds to a colour code within the structure tree of SIMARIS deSign. 

The colours represent the following:

YELLOW
You still have to input default settings for this circuit. It is mandatory 
to at least enter the cable length.
When you have fulfilled this condition, the circuit becomes GREY.

RED
In any case, this item must still be processed. This circuit has not 
been dimensioned, i. e. SIMARIS deSign has not selected a device 
for this circuit. Notes on the causes can be found in the message 
window, see chapter A.7.9 Trouble shooting. 

GREEN (or BLUE)
This circuit has been correctly dimensioned.

GREY
All of the data for this circuit is available for the calculation, however 
the circuit has not been dimensioned yet. 
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TIP
First specify your main distribution boards and then the sub-distribu-
tion boards. If you already know that you can re-insert one of the dis-
tribution boards and the connected subnetwork into the entire 
network, then continue setting up this subnetwork. In regards to the 
further procedure, deal with the settings for the connection length 
and other points relating to the specific circuit only when these are 
also to be valid elsewhere. You can copy subnetworks below the 
main distribution board and paste them in another position.

TIP
If you are colour-blind (red-green), select blue icons. You can modify 
the colour settings via the menu Extras > Settings. In the Settings 
dialog box, select Desktop > View.
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A.7.3 Editing the circuits
You can edit the properties of the circuits via the respective property 
window. You can open this window by

• clicking on the respective circuit with the right mouse button 
and selecting Properties from the context menu.

• double-clicking on the circuit with the right mouse button.
• selecting the respective circuit with the left mouse button and 

clicking on the Properties icon in the toolbar.

TIP
If an icon in the structure tree appears yellow or red, please refer to 
the corresponding information in the message box. When you open 
the Properties window of a yellow icon, the input boxes where data 
is missing are highlighted in red.

The default settings defined in the global properties will appear in the 
Properties window of the circuit (see chapter A.7.1). You can now 
modify these in the respective circuits. 

You can give the circuits individualized names. 
1 Double-click with the left mouse button on the LVMD-1.1A 

node in the structure tree. 
2 Change the name in Main Distribution.

3 Confirm your modification by pressing Enter ↵ .
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Determine which properties of the main distribution board are miss-
ing:

1 Open the Properties window of the main distribution board by 
double-clicking with the right mouse button. Missing data will 
be highlighted in red. 

2 In the Circuit system infeed dialog box, add the value 10 in the 
Length [m] text box in Medium voltage.

3 Click the ... button next to the connection. Select the value 0.7 
in the Reduction factor ftot text box.

4 In the Circuit system infeed dialog box, enter the value 20 in 
the Length [m] text box in Low voltage.

5 Confirm with OK.

The colour of the icon in the structure tree is now red, because no 
loads have yet been specified. 

TIP
In SIMARIS deSign you can select up to four parallel infeeds for the 
main distribution.
For each section of the busbar, you can select parallel circuits via the 
Circuits tab in the Circuit Infeed mask.
If you only want to process one particular circuit, select the number 
next to the Circuit icon in the structure tree and select the properties.
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A.7.4 Adding and editing circuits

A.7.4.1 Adding sub-distribution boards

This is the procedure for creating the first sub-distribution board with 
its respective loads:

1 Select the Main distribution node in the structure tree with 
the left mouse button.

2 Click on the Add sub-distribution board  icon in the toolbar. 

An additional distribution icon will be created in the structure 
tree. 

3 Double-click the sub-distribution board with the right mouse 
button.

4 Enter the value 30 in the Length [m] text box.
5 The current type of network appears in the Network system/

connection to earth text box. SIMARIS deSign will check if 
the desired type of network is permissible.
According to the DIN VDE 0100 standard, a TN-C network is 
only permissible for cross-sections Cu > 10 mm2 (or 
Al 16 mm2).
Since the basic cross-section of the connecting cable is set 
with 1.5 mm2 < 10 mm2 for the dimensioning, 
SIMARIS deSign sets the current configuration to TN-S.
Modify the type of network in TN-S in the lower window section 
under Wanted network system.

6 Confirm with OK.
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A.7.4.2 Adding loads for the distribution board

This is the procedure for adding the first load:
1 Select the LVSD1.1A.1 distribution board. 
2 Click on the Add fixed load icon  in the toolbar.

3 Click on Fixed load1.1A.1.1 in the structure tree. Open the 
Properties window by double-clicking the right mouse button 
and enter the value 20 in the Length [m] text box. 

4 Click the ...  button in the lowest section of the window to 
define the advanced properties of the fixed load. 

The Fixed load dialog box will appear. 

1 Change the Fixed load1A.1.1 designation to Lighting.
2 Enter 3+n in the Number of poles (type of network) text box.
3 Change the active power to 20 kW. 
4 Confirm with OK.
5 Close the Circuit load dialog box with OK. 

TIP
You can also rename the load directly in the structure tree.
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In the structure tree you can see that the icon in front of the 
Lighting node now appears grey. This means that all of the data 
needed for dimensioning is present for this circuit, but that the circuit 
has not yet been dimensioned. 

Complete the distribution boards for each floor with the other loads.
1 Select the LVSD1.1A.1 distribution board.

2 Click the Add non-stationary load icon in the toolbar twice.

4 Enter the value 20 in the Length [m] text box within the ’Cir-
cuit load’ dialog box.

5 Click the ... button in the lowest section of the window to define 
the advanced properties of the fixed load.

6 Change the load designation to Kitchen.
7 Select 7 kW as the active power and 1 as the capacity factor 

ai.
8 Confirm by double-clicking OK.

3 Select the Edit missing input boxes button in the 
toolbar to poll the first load.
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You will automatically change to the Properties window of the sec-
ond non-stationary load.

1 Enter the value 20 in the Length [m] text box within the ’Cir-
cuit load’ dialog box.

2 Click the ...  button in the lowest section of the window to 
define the advanced properties of the fixed load. 

3 Change the load designation to Socket-Outlet.
4 Change the number of poles to 1 and the active power to 

2.5 kW.
The rated voltage will automatically change from 400 V to 
230 V.

TIP
If you change the number of poles in the Properties dialog box first, 
the rated voltage will be automatically recalculated. 

5 Set the capacity factor ai to 0.5 to create a load reserve.
6 Confirm by double-clicking OK.

Your structure tree now looks like this:
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A.7.4.3 Adding the elevator load

This is the procedure for adding the elevator load. 
1 Select the Main distribution node in the structure tree.
2 Click on the Add fixed load icon in the toolbar.

3 Select the new load and open the Properties window.
4 Enter the value 50 in the Length [m] text box.
5 Enter TN-S as the desired network system.
6 Click the ... button in the lowest section of the window to define 

the advanced properties of the fixed load.
7 In the Fixed load dialog box, change the designation to Eleva-

tor.
8 Check if the number of poles is 3, the active power is 50 kW 

and the voltage is 400 V.
9 Confirm by double-clicking OK.

If you have entered the global settings according to chapter A.7.1, 
the characteristic data for the elevator circuit have already been cor-
rectly preset. 

Once again, this makes the function of the default settings apparent. 
It serves as a kind of circuit template:
When added, all of the circuits are created with the preset properties. 
The default settings can be modified as often as desired, since they 
only affect new circuits, not already added circuits.
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A.7.5 Copying and Pasting
The copy & paste functions are similar to the ones used in other Win-
dows applications. A distribution board corresponds to a data file. 
When you copy a distribution board, for example, you copy the se-
lected node with all of the lower-level circuits. 
You can create the Air conditioning circuit on the basis of the ele-
vator circuit:

A.7.5.1 Adding the air conditioning load

1 Select the Elevator node in the structure tree.
2 Click on the Copy selected circuits to clipboard icon  in the 

structure tree.
3 Select the Main distribution node in the structure tree.
4 Click on the Paste from clipboard icon in the toolbar.

An identical Elevator load will be added to the structure tree.
5 Change the name of the newly added Elevator load to Air 

conditioning. To do this, first click with the right mouse button, 
then consecutively with the left mouse button on the Elevator 
node. You can now rename the load.

6 Confirm the name change by pressing Enter ↵ .

ATTENTION
If you have changed the name of a load and then copy it, it will be 
added again with the same name. A load whose designation has not 
been changed will be added with subsequent numbering.
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To create distribution boards for each floor with identical loads, you 
only need to copy the first sub-distribution board.

1 Select the LVSD1.1A.1 distribution board in the structure tree.
2 Hold down both the Ctrl key and the left mouse button and 

drag the cursor to the Main Distribution node. A blue arrow 
next to the cursor indicates that the distribution board has 
been added below the main distribution. 

3 Release the mouse button.
SIMARIS deSign has now created an identical distribution,  
LVSD1.1A.2, with all of the loads. 

TIP
In this way it is possible for you to quickly create distributions for ad-
ditional floors.

This is the procedure for creating a distribution for additional floors:
1 Double-click with the left mouse button on the LVSD1.1A.1 

node in the structure tree.
2 Name the floor distribution board First floor.
3 Confirm the new designation by pressing Enter ↵ .
4 Select the LVSD1.1A.2 node.
5 Name this floor distribution board Second floor.
6 Confirm the new designation by pressing Enter ↵ .
7 Open the Properties window of the Second floor distribution 

board by double-clicking the right mouse button and enter the 
value 40 as the cable length [m]. 

8 Confirm with OK.

TIP
The mouse functions:
• Drag selected nodes to the last position of a distribution board 

by holding down the left mouse button.
• Copy nodes to the last position of a distribution board using Ctrl 

+ left mouse button.
• Drag nodes within a distibution level using Alt + left mouse but-

ton.
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A.7.6 Setting the properties of the capacitor
SIMARIS deSign is equipped with a number of different views of the 
network diagram. The single-line diagram with device parame-
ters view is activated as the standard setting. 

The Energy report view is very helpful for minimizing the connecting 
power. 

1 Select Main Distribution.
2 Select the Energy report icon in the toolbar.

In the list of loads on page A-98 as well as in the Energy report view, 
you can see that the total active power P is approx. 160 kW.

Cosϕ = 0.9 is economically optimal. 
With P = S*cosϕ, the optimal apparent power of the transformer re-
sults in approx. 180 kVA (instead of 202 kVA).
The inductive downward-flowing reactive-power component Q is 
then approx. 40 % of the optimal apparent power S, i. e. Qsoll = -
70 kvar.
The total reactive power is momentarily Qist = - 121 kvar.
With a capacitor as capacitive load, you can compensate the excess 
50 kvar q 30% of P with the following steps.
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1 Select the Single-line diagram with device parameters icon 
in the toolbar.

2 Select the Add capacitor icon in the toolbar.

3 Open the Properties window of the capacitor by double-click-
ing with the right mouse button.

4 Enter 10 m as the cable length.
5 Click on the ... button next to the capacitor icon.

The Capacitor dialog box will appear. A 10-module capacitor 
with 6 active modules has been set with 50 kvar reactive 
power each. 
With 300 kvar the capacitor is oversized.
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Reduce the capacitor power:

1 Change the value for the reactive power per module to 
12.5 kvar.

2 Change the number of modules switched on to 4.
3 Confirm by double-clicking OK.

This is the procedure for changing to the Energy report view.
1 Select the Main distribution node in the structure tree.
2 Select the Energy report icon in the toolbar.

SIMARIS deSign will automatically calculate the new values. The re-
active power Q at the busbar of the main distribution board is now 
only - 71.1 kvar. The resulting apparent power S has thus been re-
duced.
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A.7.7 Dimensioning the network
The term dimensioning refers to the selection of suitable
switching/protective devices, connections and infeed power. The ba-
sis for this is the database incorporated in SIMARIS deSign which 
encompasses all of the data for the products from SIEMENS which 
are necessary for the correct selection of equipment. 

TIP
For the first and the last dimensioning stage, it is recommended that 
the entire network be dimensioned for an overview of all of the re-
maining errors. In between you can confine yourself to dimensioning 
selected circuits and subnetworks only in order to work in a time-op-
timized manner.

1 Select the Single-line diagram with device parameters icon 
in the toolbar. 

The Main distribution node is highlighted in red. All of the 
other levels are grey. No input is missing. These networks can 
be dimensioned.

2 Select any circuit in the network.
3 Click on the Dimension all circuits icon in the toolbar.

All of the circuits will be dimensioned. In the structure tree, a 
small icon marks the circuit presently being processed. 

When SIMARIS deSign has successfully dimensioned all of the 
equipment, the circuit icons in the structure tree are all green. Red 
icons mean that the respective circuit could not be dimensioned. 
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If you have created the network according to the stipulations, the 
structure tree now looks like this:

Warning
Both modifications made to the entire system and modifications 
made to the equipment always require a new analysis of the net-
work.
Modifications can, for example, be new cable lengths or loads; as a 
result, the dimensioning must be carried out again or a switching/
protective device must be replaced.
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A.7.8 Dimensioning subnetworks
1 Select the Single-line diagram with load flow/load distribu-

tion icon in the toolbar.

2 Select the First Floor node.
3 Examine the load of the infeed of the floor distribution boards: 

The currents are very small, less than 63 A. 

4 Click on the Single-line diagram with short-circuit load icon 
in the toolbar.

The load Ib of the 
First Floor circuit
is 55.5 A.
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5 Again examine the infeed of the floor distribution boards: 

A cost-effective alternative to a moulded-case circuit-breaker is a 
fused solution:

1 Open the Properties window of the First Floor distribution 
board. 

2 Under Type of switchgear, select Fuse switch disconnector 
from the drop-down list box.

3 Confirm with OK. The node will turn red, since it has not been 
dimensioned yet. The circuit-breaker icon has changed.

 

The maximal short-circuit
current to be expected
short-circuit is 9.2 kA.

The selected circuit-
breaker is short-circuit-

proof up to 40 kA

The selected circuit-breaker
is short-circuit-proof

up to 40 kA.
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4 Select the Dimension selected circuit icon in the toolbar.

The Ground Floor circuit will be newly dimensioned. The 
downstream circuits remain unaffected. The dynamic checking 
system in SIMARIS deSign will recognise and report any faulty 
dimensioning in the outgoing circuits.

5 Open the Properties window of the Second Floor distribution 
board. 

6 Change the type of switchgear to Fuse switch disconnector.
7 Confirm with OK.
8 Dimension the Second Floor subnetwork. Select the Dimen-

sion selected subnetwork icon in the toolbar.

Only the Second Floor infeed will be newly dimensioned in a 
technically correct manner. All of the circuit icons are now 
green.
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A.7.9 Dealing with notes
SIMARIS deSign supports your project planning with explicit notes 
and messages.

The message box displays a result tree similar to the project tree.

A.7.9.1 General messages

SIMARIS deSign differentiates between messages in the circuit cal-
culation, messages in the enclosure definition and general messag-
es.

Messages listed under General messages can not be linked to a par-
ticular circuit. These are higher-level notes such as

If you click with the right mouse button in the message box, the fol-
lowing context menu will appear:

Delete general messages
All of the general messages will be deleted from the message tree.

Delete dimensioning error
All of the dimensioning errors will be deleted from the message tree.
If you ignore the message and continue working, SIMARIS deSign 
will post the note again.
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A.7.9.2 Configuration notes

The program lists the messages according to the hierarchy of the 
project structure.
SIMARIS deSign differentiates between 4 different message cate-
gories:

• Red circle - checking error
You are manually editing the network or individual circuits.
If, during the editing process, a conflict arises between the cal-
culated requirements and the selected device, a note will ap-
pear and the signal control of the affected circuit will change in 
the structure tree.
Solution: Either modify the corresponding circuit properties 
manually or have the circuit be automatically dimensioned.

• Warning with a warning triangle

Warning
The results of the dimensioning are only partially correct.
Take this note into consideration when you implement the network 
in order to comply with the protective measures.

The project tree is green.
Example:

The warning messages will be included in the output of the result 
lists (refer to Chapter A.7.12). The output format can be set in the 
menu via Extras > Settings > Calculation results.
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• Input note with a blue Info icon
Some circuits have not been dimensioned yet. You are adding 
new circuits. 
In the project tree the affected circuit is either yellow or grey.
This note requires you to supplement the minimally required in-
formation for the dimensioning. 
Example:

• Dimensioning error
The program is dimensioning the network.
This note appears when a conflict arises between the condi-
tions and the marginal requirements or the stored database 
during the dimensioning. 
In the project tree, the signal control of the affected circuit turns 
red. 
Solution: Modify the properties of the affected circuit according 
to the instructions in the message.

In this example, you have to change the installation type or the 
maximum permissible cross-section of the cable in the Proper-
ties circuit dialog box.

TIP
When you click a message, the circuit that triggered the message 
will automatically be highlighted in the structure tree. 
This message can be corrected via the Properties window. 
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A.7.10 Manual device selection

SIMARIS deSign automatically dimensions:
• Transformer capacity
• Switching devices and protective devices
• Cable cross sections

You can manually process and specify these devices at any time. 
SIMARIS deSign will take these devices into consideration when dy-
namically checking the state of the network. These components will 
be ignored during the automatic dimensioning process.

A.7.10.1 Processing transformers

Increase the transformer capacity
1 Open the Properties window of the Main distribution circuit. 
2 In the Medium voltage tab, select the ... button next to the 

transformer icon in the lower section of the window. 

3 Select the value 315 for the Rated power Sn [kVA] from the 
dropdown list box. 
The linked text box Short-circuit loss Pk [kW] will be auto-
matically updated.
The Automatic dimensioning check box has been deactiva-
ted.

4 Confirm with OK.
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A.7.10.2 Manual device selection

Via the manual device selection, you can modify the automatic se-
lection of SIMARIS deSign and select a switching device yourself. 
For this selection, SIMARIS deSign will also check to ensure that all 
of the planning requirements are complied with.
Exchange the moulded-case circuit-breaker in the main distribution 
board with an air circuit-breaker.

1 Change over to the Low voltage tab. Circuit-breaker is dis-
played in the Type of switchgear dropdown list box for the 
lower switch.

2 Click on the ... button next to the lower switch. 
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3 In the Circuit-breaker NV dialog box, click the Primary 
device... button.

4 In the structure tree, select Circuit-breakers > Air circuit-
breakers (ACB) > Circuit-breakers (In up to 3200 A, Icu up 
to 80 kA) 3WN6 > Air circuit-breaker 3WN6 for alternating 
current.
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5 Click on the New selection button. 
All of the properties of the series of switches will appear in the 
attributes box. All of the properties which have not been 
checked off in green still have to be defined.

6 In the structure tree in the right section of the window, click on 
Operating voltage (V): 415. 

TIP
The individual menu items are interactively linked with each other. 
Properties which can only assume one value due to the product 
specifications will be automatically selected. In this way it can be 
guaranteed that selected devices can really be ordered.

7 Proceed in the same way for the rest of the device properties:

Ambient temperature (°C): 50
Number of poles: 3
rated current In (A): 630
Icu (kA): 65
Overcurrent release/protective fea-
tures:

LSIN

Design/Overcurrent release: D
Type of connection, main circuit: rear connected; horizontal
Operating mechanism: Manual operating mecha-

nism with stored energy 
feature with mechanical 
closing

LCD display: Basic functions with 
LCD display

Auxiliary contact: with auxiliary contact 2NO + 
2NC

1st auxiliary release: without

2nc auxiliary release: without
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ATTENTION
In this function, the green check mark only indicates that a charac-
teristic value has been selected. It does not give any indication that 
the selected option is actually technically permissible in the affected 
circuit. Pay attention to messages in the message window.

8 As MRPD you will receive: 3WN60611DD050AA1.
After making a new selection, you can also directly enter the 
MRPD in the input box at the top on the right and confirm by 
pressing Enter↵ .

9 Confirm with Apply.
In the Circuit-breaker LV dialog box, the Automatic dimen-
sioning check box was deactivated. This means that the 
device has been taken into consideration in the calculation, 
but is frozen. SIMARIS deSign will no longer automatically 
change it. The query with the network requirements and the 
notes will remain, however.

10 Confirm by double-clicking OK.
The manual selection is clearly marked in the structure tree by 
a small blue hand next to the icon. 

Increasing the transformer capacity increases the short-circuit cur-
rents. The Second Floor subnetwork has been incorrectly dimensio-
ned.

1 Select the Second Floor node.
2 Select Dimension selected subnetwork.
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A.7.10.3 Processing cable selection

• Select the Main distribution node and change over to the load 
flow view.

The permissible 
load is smaller than

In2 of the transformer
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Increasing the cable cross section.
1 Open the properties window for the Main distribution circuit.
2 In the Low voltage tab, click on the ... tab next to the connec-

tion.

3 For the Cross section of external conductor [mm2], select 
the value 185 from the drop-down list box. The linked Cross 
section of external PEN conductor [mm2] text box will be 
automatically updated. The Automatic dimensioning control 
box has been deactivated.

4 Confirm twice with OK.
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A.7.11 Setting the protective devices

A.7.11.1 General information

In the Selectivity view you can
• observe the tripping performance of each protective device in 

terms of the selected limits and the devices connected up-
stream and downstream.

• manually carry out the protective settings for adjustable 
devices. SIMARIS deSign supports you with a report of the cur-
rent state.

Since the characteristic curve is dependent on the type of device, 
this view is only available after dimensioning.

1 Select the First Floor distribution board in the structure tree. 
2 Select the Selectivity icon in the toolbar.

In the message window you will receive a message regarding selec-
tivity for each circuit. You can activate these messages via the Ex-
tras > Settings menu. In the structure tree, select Settings > 
Desktop > Messages to specify the number of selectivity messag-
es.
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In the displayed diagram you can see the current-time characteris-
tics of the upper switch of this circuit in relationship to the switches 
connected upstream and downstream.

As a standard setting, the different lines are designated by specific 
colours:
Yellow designates the upper switch of the current circuit.
Green designates the lower switch of the current circuit.
Blue designates the sum total envelope curve of all of the higher-level 
devices.
Red designates the resulting characteristic curve of the next down-
stream circuit level.
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Diagram options
1 Click with the right mouse button in the diagram box to display 

the context menu.

2 Select Diagram options.
3 You can select the limit values and characteristic curves to be 

displayed in the diagram using the check boxes in the input 
mask.

4 Click Apply to apply your settings that were previously only 
valid for this specific circuit to all of the other circuits in the net-
work.

5 Confirm your modifications by clicking OK and change over to 
the updated diagram.

Defining screen colours
1 Click with the right mouse button in the diagram box to display 

the context menu.
2 Select Screen colours.
3 Select a node in the left section of the window and define the 

colours of the screen diagram as desired.
4 Click Apply to see your colour modifications in the diagram. 

The Local default colour set button deletes your modifica-
tions and selects the standard combination.

5 By clicking OK you will return to the diagram.
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Printer colours
1 Click with the right mouse button in the diagram box to display 

the context menu.
2 Select Printer colours.
3 Define the colours of the data output diagram as desired.
4 The Load Black&White printer defaults button displays the 

standard settings of the respectively selected colour or 
black&white printer.

5 With Preview in the selectivity screen you can see the view 
of your personal colour selection.

TIP
For the black&white printer, select different colour intensities for the 
curves. The curves can then be more easily differentiated in the 
printout.

Printing
1 Click with the right mouse button in the diagram box to display 

the context menu.
2 Select Print.
3 Select your choice of printer for the selected curve diagram.
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Saving as a GIF image
1 Click with the right mouse button in the diagram box to display 

the context menu.
2 Select Save as GIF image.
3 Save your curve diagram in the desired folder in GIF format. 

WARNING!
The upper and lower tolerance bands help to make it easier to eva-
luate selectivity. The tolerance bands are displayed in 
SIMARIS deSign in a simplified manner. However, with a high pro-
bability, the tripping character of the switches remains within this 
range. Please refer to the operating manuals of the respective indi-
vidual switches for detailed information on their exact behaviour.

A.7.11.2 Viewing selectivity

In SIMARIS deSign, Backup protection is set as the standard for 
the dimensioning priority.

TIP
This setting can be modified separately for each circuit:

1 With the right mouse button, double-click on any circuit in the 
structure tree.

2 Click on the Circuit properties button. In the Circuit proper-
ties dialog box, you can select the dimensioning target and the 
resulting evaluation for each circuit.

3 By clicking Accept, you can accept your settings for all of the 
existing circuits within a network. If you want to accept your 
settings as defaults for new circuits, click on the As default 
button. These network-specific defaults will then be imported 
under Network > Low voltage > Default values > Circuit > 
Circuit properties.

• Select the Capacitor load in the structure tree.
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In the following diagram you can see the current-time characteristics 
for the switch of this circuit (yellow) in relationship to the higher-level 
incoming circuit-breaker (blue).
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Ikmax Maximum short-circuit current which the current switch must 
resist.
For the instantaneous short-circuit release Ii the condition  Ii < Ikmax 
is valid.

Ikmin Minimum short-circuit current which the current switch must dis-
connect.
For the short-time delayed short-circuit release Id the condition 
Id< Ikmin is valid.

Isel Calculated selectivity-limiting current, i. e. the intersection of the 
displayed curves. For the automatic evaluation, SIMARIS deSign 
distinguishes between intersections 

in the overload range: In <= Isel-overload < Ikmin

and the short-circuit range: Ikmin <= Isel-short circuit <= Ikmax

If there is an intersection within the overload range, an intersec-
tion within the short-circuit range will be neglected.

Two switches are fully selective to each other when Isel > Ikmax.
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You can now modify the properties of the  characteristic curves via 
the linear regulator to the left of the diagram. 

1 Slide the regulator of the overload release Ir slightly down-
ward. You are now violating the overload condition.

 

In the background, SIMARIS deSign will simultaneously check the 
overload, tripping and short-circuit conditions. As soon a a conflict 
about the requirement arises, it will be displayed in the message win-
dow and the respective circuit nodes will change colour.

2 Slide the regulator of the overload release Ir back to 182 A.

TIP
Click on the scale above or below the regulator to set a parameter 
one step lower or higher.

The short-circuit release Ii is at 2000 A
.

1 The intersection Isel-overload shows that the protection setting in 
the upstream devices must be changed in order to increase 
selectivity.

2 Select the Main Distribution node.
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The characteristic curves of the incoming switch (green) and the 
upstream switch (red) intersect in several places within the overload 
and short-circuit range.

In oder to reach selectivity and dissolve the intersections, the green 
characteristic curve must be moved to the right. The intersection 
Isel-overload with the HV HRC fuse must be additionally moved within 
a tripping range of < 0.1 seconds.

1 Set the release of the overload range Ir to 473 A.

2 Activate the check box li to infinity.

3 Slide the regulator td for the short-circuit delayed release to a 
minimum of 0.02 s.

4 Select tr = 10 s as the tripping time.
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5 Slide the regulator for the short-time delayed release Id to 
2835 A, i.e. below the blue curve.

6 Click the key next to the designation Main Distribution to lock 
or unlock your selected settings. 

This corresponds to deactivating the Automatic dimensioning
button. The settings will then be taken into consideration for the cir-
cuit calculations, but will no longer be automatically modified.

The Selectivity icon for the circuit capacitor remains unchanged. 
1 Select the Capacitor node.
2 The intersection Isel-overload is now at 2268 A. Slide the regula-

tor for the li release down to 1800 A.
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The protective device of the capacitor is now completely selec-
tive to the incoming switch, i. e. the curves do not intersect.
All of the Selectivity icons downstream from the infeed are 
green and the network is fully selective on the secondary side.
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A.7.12 Output of results
In this section, as required by the task, you will generate 

• an overview block diagram
• the results of the network calculation

1 Select the Network 1.1 node in the structure tree. 
2 Click the node with the right mouse button to display the con-

text menu. 

3 Select Output to Screen (file).
4 Activate Network diagram (FelixCAD) as well as all of the 

check boxes under Calculation results.
5 Select Entire network or Subnetwork.

All of the circuits below the highlighted circuit Network 1.1 will 
then be included in the output.

If desired, it is also possible to only output the results from 
parts of the network. 

6 Confirm with OK.

It is only possible to output the text for tender docments when the en-
closure has also been dimensioned.

All of the necessary applications will automatically open.
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When SIMARIS deSign was installed, FelixCAD was also installed. 
The block diagram is generated in FelixCAD and can be further 
edited (printed, saved as .dwg/.dxf) there. 

1 For your output in FelixCAD, select a network view. The icons 
correspond to the view icons in SIMARIS deSign. 

2 Select the Settings icon in the toolbar to 

• select a manufacturer-neutral view.
• select the number of displayed levels per page. One level cor-

responds to a level in the structure tree. 
For the current example, select 4.

3 Confirm with OK.
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The results of the network calculation and the equipment dimension-
ing will be summarized in a table. It is possible to change from one 
table to another one via the tabs on the lower edge. The tables can 
be further edited here. 
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A

A.8 How do I define the enclosure?

A.8.1 General information
When defining enclosures, the smallest possible enclosure in which 
all of the devices determined by the calculation module can fit is se-
lected from the database. A rough suggestion is also made for the 
general distribution of space within the enclosure. 

ATTENTION
The enclosure is dimensioned without the influence of the ambient 
conditions. It is therefore necessary to take derating factors into ac-
count when configuring the switchgear! (For example, derating fac-
tors for the ambient temperature, installation elevation, packing 
density, IP degree of protection, etc.)

The enclosure is always dimensioned in relation to the previously 
calculated network and can only then be correctly dimensioned 
when all of the nodes in the circuit dimensioning are green, i. e. 
when they have all been successfully dimensioned.
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The enclosure preferences can be directly defined in the Default 
settings net dialog box. After being confirmed, the settings immedi-
ately affect your project and the network.

1 Open the dialog box for the settings by double-clicking with the 
right mouse button on Network 1.1.

2 Select Project > Low voltage > Settings > Enclosure defini-
tion > Product preferences in the structure tree. 

You can now deactivate particular types of distribution boards 
or set priorities in the right section of the window. 

3 Deactivate ALPHA160 by clicking on the respective check 
box.

4 Give SIVACON 8PT priority. 

These are all of the default settings for this model project.

5 Confirm with OK.
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A.8.2 Dimensioning the enclosure
The procedure for dimensioning the enclosure is schematically sim-
ilar to the procedure for dimensioning the network:

• For the first and the last dimensioning stage, it is recommended 
that the entire network be dimensioned. 

• In between you can confine yourself to dimensioning  selected 
enclosures only in order to work in a time-optimized manner.

1 Open Planning > Enclosure definition > Medium voltage1 
> Network 1.1 > >Distribution board > Low voltage in the 
structure tree. 

2 Click on the Dimension all enclosures icon in the toolbar. 

When the enclosure has been selected, all of the circuits currently 
being processed are marked by a small icon:

• If a distribution board has been successfully delegated to an 
enclosure, the respective icon is green after the processing has 
been completed.

• If it is not possible to delegate a distribution board or if no se-
lection is possible, a message will appear and the icon will be 
red.

For an overview of the enclosures, open the complete tree under  
Low voltage.

If you now successively select the individual nodes and view the re-
spective images in the right section of the window, you will see dif-
ferent views of the enclosure: 

• If you select the icon of a distribution board, i. e. Main distribu-
tion, in the structure tree, a schematic dimensioned drawing of 
the selected enclosure will be displayed. 

• If you select, for example, Panel 1 in the structure tree, the 
switchgear cabinet will be displayed with all of the correspon-
ding devices.
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A.8.3 Manual enclosure selection
As described in chapter A.8.1, certain enclosures could already be 
eliminated or particular types could be given priority in the global de-
fault settings. It is also possible to manually replace the enclosures 
automatically selected by SIMARIS deSign with other types of en-
closures. 

1 Open the Properties window of the enclosure for the Main 
Distribution. 

2 In the Distributor type section, select SIKUS 3200 from the 
drop-down list. 

3 Confirm with OK.

TIP
When you manually select an enclosure, the Automatic dimen-
sioning check box will be deactivated. When a new dimensioning is 
carried out, the enclosure will no longer be modified. It is also possi-
ble to manually deactivate the check box if, for example, you want to 
retain an automatically selected enclosure even after modifications 
have been made to the circuit.

If you now successively select all of the sub-items of the enclosure 
you will see that some of the properties have automatically been 
modified:
The Main Distribution now shows a schematic diagram of the 
SIKUS enclosure with the modified dimensions.
The panels were automatically adjusted to the new type of enclo-
sure.
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A.8.4 New placement of devices in the panels

In the case of self-contained enclosures, you can drag selected de-
vices to new panels and thus manually vary the placement within 
your panels.

1 Select Main Distribution_Panel 2 in the structure tree. 

SIMARIS deSign will automatically place the 3VL compact cir-
cuit-breaker and the 3NP fuse strip in this panel. Now place 
the compact circuit-breaker in its own panel.

2 Hold the shift key  down and select items 2 through 4 in 
the list of devices by clicking with the left mouse button.

3 Select the Place in new panel button.

A new Panel 3 will be automatically generated in the structure 
tree. 

Small red arrows indicate both the panel out of which a device 
was taken and the panel to which the device was added.

4 Click on the Main Distribution_Panel 2.
Only items 5 and 6 are left in the device list. They are marked 
by a hand. 

�
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A.8.5 Dragging panels
You can customize the arrangement of the panels within a distribu-
tion board.

1 Select the Main Distribution_Panel 1 node.
In the diagram, the circuit-breaker is to be placed to the left in 
Panel 1 of the main distribution board.
 

2 Hold the left mouse button down and drag the mouse cursor to 
the  Main Distibution_Panel 2.
The cursor indicates with a blue arrow that Panel 1, which is 
highlighted in purple, has been dragged below Panel 2.

3 Release the mouse button.
4 Select the Main Distribution node.

TIP
If you drag a panel, a blue arrow next to the cursor indicates whether 
the panel will be added above or below the selected node.
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The diagram under the Main Distribution has now also been modi-
fied.

TIP
If you drag a panel, the panel will always be added to the circuit over 
which the mouse button has been released.
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A.8.6 Output of results
In this section, as required by the task, you will generate documen-
tation for

• the space requirements in the distribution boards
• the specifications of work and services 

1 Click with the right mouse button on Main Distribution in the 
structure tree.

2 Select Output to Screen (file)  from the context menu.
You can determine the output properties in the Output dialog 
box. 

3 Activate View enclosure.
4 Deactivate Calculation result.
5 Activate Price List (field-related invitation to tender).
6 Confirm with OK.

The necessary applications will automatically open.
To retain the enclosure view for the First Floor and the Second 
Floor sub-distribution boards, proceed accordingly without step 5.
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TIP
The Material price calculation option can only be used if you have 
previously loaded the material prices in the program. This function 
can only be used with a licensed single-terminal or multiuser version.
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A.8.7 Medium voltage
The medium voltage enclosure can only be defined after the medium 
voltage calculations for a network have been completely and suc-
cessfully carried out. 
The PROFIX 8DH10 tool is integrated in SIMARIS deSign:
PROFIX enables you to create a block diagram, a front view of the 
enclosure and layout drawings.
You can estimate the space needed for the medium voltage system.
You can configure the necessary field types for the 8DH10 medium-
voltage system.
The values calculated by SIMARIS deSign are highlighted in grey in 
the master data and can only be modified in the SIMARIS deSign-
interface.

1 Select the Medium voltage node in the Enclosure Definition 
structure tree.

2 Open the context menu with the right mouse button.
3 Click on Start Profix.
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The window is divided into two sections:
• List of  typicals:

In Profix for SIMARIS deSign, the configured secondary infeed 
is automatically stored as a typical.

Abbreviations:
LS Circuit-breaker panel
RK Ring cable panel
TR Transformer panel
LTx Bus tie, versions 1 & 2
ME1 Metering panel
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• List of panels
Profix has created transformer feeder panels based on the im-
ported typical corresponding to the number of transformers de-
fined in SIMARIS deSign.

Further information on configuration can be found in the separate 
Profix 8DH10 user’s manual on the installation CD under  PROFIX.

TIP
The following free software is included on the CD:

• PROFIX SIMOSEC (air-insulated, applicable up to 24 kV, 
25 kA and 1250 A)

• PROFIX NXPLUS C (gas-isolated, applicable up to 24 kV, 
31.5 kA and 2500 A) for configuring switchgear on your own.

The setup files, installation and operating instructions are in the 
PROFIX path.
Manually accept the technical requirements from SIMARIS deSign. 
Configure independently according to your own needs.
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A.9 How do I exit the program?

A.9.1 Saving and exporting the project
You can use the respective icons in the toolbar to save the project.

• Click Save current project or

• click Save current project as....

TIP
SIMARIS deSign has its own project management. You have al-
ready become aquainted with it in the Management module in chap-
ter A.6.3. 

Saving as described above only saves the project within this ma-
nagement database. 
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Use the Export function to save a project in a folder outside of the 
SIMARIS deSign folders if you, for example, wish to further edit it on 
another computer.

1 Click on the Administration > Projects menu item.

SIMARIS deSign will change over to the Management module.

2 Select TUTORA1 in the list. 
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3 Select the Export button. 

You can enter both the storage path and the name of the 
export file in the Export project dialog box. SIMARIS deSign 
project files have the extension .poz .

4 Confirm with Save.
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A.9.2 Exiting SIMARIS deSign
Exiting SIMARIS deSign is similar to other Windows applications.

Select File > Exit in the menu. 
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AA.10 Which abbreviations & standards are  
used in SIMARIS deSign? 

A.10.1 Standards 

SIMARIS deSign takes the following standards and regulations into 
account for dimensioning and calculation. 
 

The diagram illustrates interrelations between the individual stan-
dard designations. 

The following SIMARIS deSign relevant parts und excerpts are con-
sidered

•  for dimensioning circuits.
•  for dimensioning connections.
•  for inserting devices into their respective enclosures.

 
International 

Europe 

Country 
e.g. Germany  

IEC

HD

DIN VDE

EN

DIN VDE
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The table lists the standards and regulations considered in 
SIMARIS deSign.

SIMARIS deSign takes the permissible standards for the selected 
destination country into account.

DIN VDE regulation IEC publications and CENELEC harmonisation documents 
or EN regulations

Titel Nr. Teil Title IEC-Pub. HD EN

Errichten von Starkstrom-
anlagen mit Nennspannun-
gen bis 1000 V

0100 100 - 600 Scope, object, 
fundamental 
principles

60364 384

Kurzschlussströme der 
Ströme in 
Drehstromanlagen

0102 Short-circuit 
currents - 
calculations in three-
phase a.c. systems

60909

Kurzschlussströme - 
Berechnung der Wirkung

0103 Short-circuit cur-
rents - Calculation of 
effects

Niederspannungs-
Schaltgeräte - Leistungs-
schalter

Specification for low-
voltage switchgear 
and control gear - 
Circuit-breakers

60947-2 60947-2

Begriffe und Berechnungs-
verfahren

1 Definitions and cal-
culation methods

60865 60865

Niederspannungs-Schalt-
gerätekombinationen

0660 500 - 506 Low-voltage switch-
gear and control 
gear assemblies

60439

507 60890 +C 520 S2

Verwendung von Kabeln 
und isolierten Leitungen für 
Starkstromanlagen

0298 4 60384
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A.10.2 Terms & abbreviations 

SIMARIS deSign uses the following abbreviations, in particular for 
default settings and calculation results.

Currents 

I2 Large test current [A]

Ibel Load current [A]

Ibem Rated setpoint current of the switching device [A]

Ibw Active load current [A]

Ibb Reactive load current [A]

Ibs Apparent load current [A]

Icm Rated short-circuit making capacity [A]

Icn Ryated ultimate short-circuit breaking capacity [A]

Icu Rated ultimate short-circuit breaking capacity [A]

Ics Rated service short-circuit breaking capacity [A]

Icw Rated short-time withstand current (r.m.s. value) [A]

I∆n Rated fault current [mA]

Igw Total active current [A]

Igb Total reactive current [A]

Igs Total apparent current [A]

Ik Continuous short-circuit current [A]

Ik1max Maximum 1-pole short-circuit current [A]

Ik1min Minimum 1-pole short-circuit current [A]

Ik2min Minimum 2-pole  short-circuit current [A]
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Ik3max Maximum 3-pole short-circuit current [A]

Ik3min Minimum 3-pole short-circuit current [A]

Ipk Rated peak withstand current [A]

Ith Thermal fault-withstand capability (cf. Icw) [A]

In Rated device current for the operating current [A]

Inmax Rated device current at a  
standard temperature of 40 °C

[A]

Inzul Permissible circuit-breaker load [A]

Isel Calculated selectivity-limiting current [A]

Izul Permissible cable load current [A]

Ir Set value of the overload (L)-release [A]

Rel Ir Relative current value of the L-release [A]

Abs Ir Absolute current value of the L-release [A]

Id Set value of the short-time delayed short-circuit (S)-
release

[A]

Rel Id Relative current value of the S-release [A]

Abs Id Absolute current value of  the S-release [A]

Ii Set value of the instantaneous short-circuit (I)-
release

[A]

Rel Ii Relative current value of the I-release [A]

Abs Ii Absolute current value of the I-release [A]

Ig Set value of the release for the earth-fault detection [A]

Rel Ig Relative current value of the G-release

Abs Ig Absolute current value of the G-release [A]
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Voltages

Un Rated voltage [V]

UNenn Rated device voltage [V]

UNetz Rated network voltage [V]

Ukr Rated short-circuit transformer voltage [%]

∆U Cumulated voltage drop of the network diagram 
node

[%]

∆Uk Total voltage drop up to the indicated node dis-
played in the Quick Info

[V]

∆Urel Relative voltage drop of the current path/circuit in 
the Quick Info 

[%]
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Resistances

R1 Resistance of positive phase-sequence system [Ω]

X1 Reactance of positive phase-sequence system [Ω]

Z1 Impedance of positive phase-sequence system [Ω]

R0 Resistance of zero phase-sequence system [Ω]

X0 Reactance of zero phase-sequence system [Ω]

Z0 Impedance of zero phase-sequence system [Ω]

r1 Specific active resistance of the positive phase-
sequence system

[mΩ/m]

x1 Specific reactance of the positive phase-
sequence system

[mΩ/m]

r0ph-n Specific active resistance of the zero phase-
sequence system for the phase/neutral conduc-
tor loop

[mΩ/m]

x0ph-n Specific reactance of the zero phase-sequence 
system for the phase/protective conductor loop

[mΩ/m]

r0ph-
pe

Specific active resisance of the zero phase-
sequence system for the phase/protective con-
ductor loop

[mΩ/m]

x0ph-
pe

Specific reactance of the zero phase-sequence 
for the phase/protective conductor loop

[mΩ/m]

R0∆U Resistance of the zero phase-sequence system 
at the cable at the selected calculation tempera-
ture for the voltage drop, 
Standard: 55 °C

[mΩ]
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Energy and power

X0∆U Reactance of the zero phase-sequence system 
at the cable for the voltage drop, independent of 
the temperature

[mΩ]

X1∆U Reactance of the positive phase-sequence sys-
tem at the cable for the voltage drop, indepen-
dent of the temperature

[mΩ]

R1∆U Resistance of the positive phase-sequence sys-
tem at the cable for the selected calculation 
temperature for the voltage drop, 
Standard: 55 °C

[mΩ]

Re Sum of the resistance of the earth connections 
and the possibly wired protective conductor bet-
ween exposed conductive parts and earth in the 
TT network.

[mΩ]

Ra Sum of the resistance of the earth connections 
and the possibly wired protective conductor bet-
ween exposed conductive parts and earth in the 
IT network.

[mΩ]

P Active power [W]

Q Reactive power [var]

Qe Active capacitor VAr [var]

S Apparent power [VA]

pv Related (active) power loss [%]

I2t Cut-off I2t value

S2K2 Thermal fault-withstand capability of the cable
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Factors

Other parameters

ai Capacity factor

b Type of load (ind. = -1/cap. = +1)

c Voltage factor

ftot Reduction factor

gf Simultaneity factor

ϕ Phase angle of the current *180 / π

cos (ϕ) Power factor

fnenn Rated device frequency [Hz]

fNetz Rated network frequency [Hz]

pz Number of poles

ta, zul. Permissible tripping time [s]

tr Time value of the L-release (absolute) [s]

td Time value of the S-release (absolute) [s]

ti Time value of the I-release (absolute) [s]

tg Time value of the G release (absolute) [s]
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Indices

Tu Ambient device temperature [°C]

L Phase conductor

N Neutral conductor

PE Protective conductor

F1 The displayed short-circuit current is related to a 
fault in the busbar.

F2 The displayed short-circuit current is related to a 
fault on the primary side of the transformer.

F3 The displayed short-circuit current is related to a 
fault on the secondary side of the transformer.

max Maximum

min Minimum

NB Downstream equipment

Nenn or n Rated, nominal

Netz Network ..., Operating ....

i Running index variable

T Transformer

v Device

VB Upstream switching device

zul or  z Permissible
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Other abbreviations

Dev Device

Fumo Functional module

MBB Main busbar

L1 Phase 1

L2 Phase 2

L3 Phase 3

MRPD Machine-readable product designation

MV Medium voltage

LV Low voltage

LVMD Low-voltage main distribution

LVSD Low-voltage subdistribution

DMT Definite-time overcurrent-time protection

MW Modular width
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SIMARIS deSign language:

Back-up protection Interaction of two co-ordinated series-connected overcurrent protec-
tive devices in locations where the downstream device, e.g. an MCB, 
cannot switch the prospected short-circuit current independently in 
the event of a fault. 
The upstream protective device will then take some load off the clo-
sest downstream protective device thus preventing excessive stress 
on this device. 

Calculation refers to a node in the structure tree. 
Calculation in SIMARIS deSign includes:

- definition of the marginal conditions, also default settings of a net-
work,

- building and processing a network while the program is simulta-
neously performing load flow and short-circuit calculations for the 
present state.

- dimensioning

Enclosure 
definition 

includes all operations from the selection of a type of enclosure for 
the configured devices up to the subsequent specification of certain 
properties. 
If you have correctly dimensioned the network in the calculation 
mode, you can now define the enclosures.

Dimensioning You have to distinguish between the nodes for calculation and en-
closure definition. In dependence of the marginal conditions such 
as network data and standard etc. which you have defined, the pro-
gram automatically selects the following in the calculation mode:        

- the required infeed power
- suitable cable cross-sections
- suitable switching devices and their overcurrent protection 

In dependence of the marginal conditions, such as destination coun-
try and standard etc. which you have defined, the program automati-
cally selects 

- suitable distribution board housings 
in the enclosure definition.
SIMARIS deSign A-113



Which abbreviations & standards are used in SIMARIS deSign? SIEMENS
Connection to 
earth

Conductive connection between the conductive part to be earthed 
and the earth potential. (also see Network system)

Node Within the scope of program “node” designates a branch in the struc-
ture tree.
Branches below the calculation node electrically correspond to a 
subnetwork. The smallest node is a load circuit.
Branches below the enclosure definition node correspond to the 
distribution board components: main busbar, devices and panels.
Branches below the project data node refer to project-administrati-
ve elements:  user, customer and project.

n-1 principle refers to the safety principle of infeed applied in SIMARIS deSign.
A prerequisite for this option is that the number of parallel infeeds is  
> 1.
This function ensures fault compensation for one infeed device by 
the remaining n-1 infeed devices. 
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Network system Electrical networks can be distinguished according to their voltage, 
design and shape:
SIMARIS deSign is suitable for radial networks up to 1000 V. 
This means with regard to SIMARIS deSign, the data box ’network 
system’ only refers to the shape of the network. It is determined by 
the type of earth connection of the neutral point and the exposed 
conductive parts. The following illustration depicts the network vari-
ants permitted in SIMARIS deSign:

Selectivity defines the interaction of series-connected overcurrent protective 
devices in order to limit effects of a fault in space and time.
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Circuit A circuit consists of the following elements:
• network system/connection to earth
• switching device, top
• Connection
• switching device, bottom
• power consuming device or distribution board (Network sys-

tem/connection to earth)

Fixed circuit types in the SIMARIS deSign planning:
• LV main distribution 
• LV subdistribution
• fixed load
• non-stationary load
• capacitor

Power consuming 
devices

Devices which transform electrical energy into a different type of en-
ergy.

Distribution board Part of an electrical installation which distributes energy to the 
downstream power consuming devices or device groups.
A distribution board consists of

- busbar system
- switching devices

for outgoing cables and wires.

The components are mounted into the respective enclosures. One 
unit constitutes a panel.
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A.11 Literature
SIMARIS deSign is a planning aid which provides a network calcu-
lation and device selection based on your network concept and its 
marginal conditions. 

You will also find more detailed information on network planning in:

1. Planning of Power Distribution - 
the manual for Totally Integrated Power
Siemens AG
Erlangen, 2001

2. Electrical Installation Technology,
by Günter Seip, Siemens AG
4th edition, Erlangen, Munich: Publics-MCD Publishing House, 
2000
ISBN 3-89578-160-6

3. Switching, Protection and Distribution in Low-Voltage Net-
works
Siemens AG
4th substantially revised and expanded edition
Erlangen, Munich: Publics-MCD Publishing House, 1997
ISBN 3-89578-041-3

4. Power Engineering Guide (only available in English)
Siemens AG
Erlangen, 2000
www.ptd.siemens.de/de/pages/powereng.htm

• Enter Power+Engineering+Guide in the Look for: text box.
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A.12 Further information
You will find further information on products of the SIMARIS range, 
such as

• SIMARIS deSign

• ALPHA P.I.S.A.A

at:

www.siemens.de/simaris

Our hotline is available at:
+49 (0)7000-SIMARIS 
+49 (0)7000 7462747
E-mail: simaris@siemens.com
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A.13 Template of the device list for the introductory example
Project number: 12345
Project name: TUTORYA1
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1 Lighting 1st floor TN-S fixed 3+n 20 400 0,8 1 20 multi-core cable PVC70 Cu free below ceiling 0,7 4

2 Kitchen 1st floor TN-S non-stationary 3+n 7 400 0,8 1 20 multi-core cable PVC70 Cu free below ceiling 0,7 4

3 Socket-Outlet x 1st floor T-NS non-stationary 1 2,5 230 0,8 0,5 20 multi-core cable PVC70 Cu free below ceiling 0,7 4

4 Lighting 2nd floor TN-S fixed 3+n 20 400 0,8 1 20 multi-core cable PVC70 Cu free below ceiling 0,7 4

5 Kitchen 2nd floor TN-S non-stationary 3+n 7 400 0,8 1 20 multi-core cable PVC70 Cu free below ceiling 0,7 4

6 Socket-Outlet 2nd floor T-NS non-stationary 1 2,5 230 0,8 0,5 20 multi-core cable PVC70 Cu free below ceiling 0,7 4

7 Board 1st floor Main distribution 1 TN-S 30 multi-core cable PVC70 Cu free below ceiling 0,7 4

8 Board 2nd floor Main distribution 1 TN-S 40 multi-core cable PVC70 Cu free below ceiling 0,7 4

9 Elevator x Main distribution TN-S fixed 3 50 400 0,8 1 50 multi-core cable PVC70 Cu free below ceiling 0,7 4

10 Air-condition Main distribution TN-S fixed 3 50 400 0,8 1 50 multi-core cable PVC70 Cu free below ceiling 0,7 4

11 Main distribution Network 1 TN-C 20 multi-core cable PVC70 Cu free below ceiling 0,7 4
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